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3.2.5 GPIO T oottt ettt e et e ettt r e 13
B T R oottt ettt ettt ettt ettt e et et e et 14
B T I oottt ettt ettt e ettt ettt et ettt et en ettt enes 14
411 GEIE TAR FTTF @XAMPIE....coveiieieieiiiee e 14
B2 FEII TR oot 15
R =Y o 1] - L PSP 16
B3 FE T oottt ettt ettt ettt ettt ettt ettt et er et en e 18
B.3.1 IDE BEE oo ettt ettt ettt ettt et e ettt er e 18
B.3.2 ISP 5 .ottt ettt 19
BB AL TR oo ettt ettt ettt et 22
B B ettt ettt ettt ettt ettt ettt ettt ettt en et 23
B. L T T ] oottt ettt ettt ettt ettt ettt ettt et et et et et et et et et et et et et et e nnnes 23
B R BBl oottt ettt ettt ettt ere 25

STK B4/ - FM Page 2 of 25



FDSC £A%S%

HUADA SEMICONDUCTOR

1. i

A ¥ EA Y HC32F146 %741 Starter Kit (STK) JFREM:, ZEMEEET HC32F146 R4,
AAEMER. A, KIhFE. B OF 255N, HC32F146 R%1:85 KA ARM Cortex-MO+
WAZ I THR 32 Arfida il ey, Bk EM 48MHZ. £:k FLASH 128Kbytes. £ K SRAM 8Kbytes,
Y FE LCD i %% 12 /7 ADC ##e2%. 3 B UART. 12C. SPI ZIIfEiE S . 4 ME A ER %5,
PR AR S LA 2% . SR PLL. SCfF 2.7V~5.5V fiEE %, 3& 3 A N sl A 9% e 1
M.

HC32F146 # % Starter Kit ££/% 1 CMSIS DAP M5 H, G 21 & 3 W0 LA R 2% Ik Al
W, JF 32 SWD #2101, [F 4L HC32F146 R A1 A bRtk [l 4422 & MCU A& B IEAE F AL,
TR mr AP F 48 R 7 AT TR
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1.1 FKRRNE

B 1-1 JPRRBHE 4

1. 5V, 33V HIE#EO (CN2) 10. 3.3V RE

2. ADC RFEfiA#L (CN3) 11. HC32F146 %41 MCU HLJEBkIE (34)

3. HC32F146 %% MCU TAEM &R I3 12. CMSIS DAP ik it TAEREALEE (31D
4. IRIEALRER 13.  J-Link SWD iz 11

5. HFkH (Swi 14. CMSIS DAP ik USB %11 (CN1)
6. EEPROM 15. HC32F146 %% MCU

7. LED3 16. ¥ EIhRERLT (CN5. CN6)

8. HEf&H (Sw2) 17. LCD f/RpF

9. HUREENIS

B 12 TP R IR4H
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1.2 ey iz

K 1-1 FFRARBRZRA 41

e hek s L 9N
8 CMSIS DAP itk | WIF: BTt i}
J1 " W
HeLARRA Wi EATIR(E B
BWE HC32F146 AP | b e ooy "
J3 TR MR PATEER W
VI HC32F146 R4 A | WiIT: WiJT HC32F146 R A1 AL -
Ja S s LR
LR fE WifE: PEE HC32F146 21145 i
1 izﬂéj% HC32F146 %5”7&:#‘— %E*% fﬁ:)ﬂfﬂé EE/)E% 5V Q%EE ]i:ﬁﬁ
5V L LA WigT: EE gt
3 PR HC32F146 R0 | Ak O YN 3.3V it -~
3.3V kit Wi AT e
F® 12 FFRRFEINH
s L= iEH
1 CN1 CMSIS DAP i USB #:0
2 CN2 5V. 3.3V HLEEN
3 CN3 ADC EFH AN
4 CN4 J-Link SWD i3 1
5 CN5/CN6 TEoeE N

1.3 A48

AT BRI - B HC32F146 #%1) Starter Kit:

o LR

A IR AT 22 2 S A R IR e e T R B AT D A

® (LK T IR T HC32F146 R 41 Starter Kit (¥ EZRFIERITIAE, W1 CMSIS DAP i 1%
Hi. LCD &5 . EEPROM JiLFE fi Rk Ha 5,

® WA R AT HIA T 7F 1AR Embedded Workbench FF & ¥R 385 U] 4T - H3E 47— AMEEG] THE,
J Al N R IR R

® [ff 53t HC32F146 %% Starter Kit [{1355 4> 2% W% [ 223 CHik

1.4  HABTIR

R ORI P it 3R O TR 5 EdE,  http://www.hdsc.com.cn/ #BIRIEFE53E 1)
MCU Jf-F5 B R ERIEA ROt & SR B ENUR A7 b Bt
MCU T #+:, HC32F146 7% Starter Kit AH2CHRHE 275 LR SCR:

® User Guide: HC32F146 %% Starter Kit /i /7 F-ift

® Device Selector: MCU &% Fiit.

STK B Flit
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HUADA SEMICONDUCTOR

1.5  #ilgin]
* 1-3 gt

ZEREAE iEA

FLASH Flash (R4 55 26 VA7 i 58 T BAR R A0 1 77t 28 2P TR M AT 45 5 o R 2
SRAM %&%MﬁWﬁﬁﬁcE%*ﬁﬁﬁ%iﬁﬂ%%%Wﬁ,K%EW%%%W%%

76 A AT T U

LCD T T
ADC BT RS . RARRE LA RIS SR oM B U BUT5 5 A1
UART SO A, R OR A
SPI BATANE N, R, AW, RS Rk
lc RN, RRRIR. BUA. ZgkHl. R EITRE

CMSIS DAP ko
SWD AT

EEPROM AT T A A, — gt R BR AN BRI
LED R HE
usB P A AT A2
MCU P s T, SORRE T SR T L B A
ISP TEL R G dmis
CMO+ Cortex-MO+
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FDSC &A%

HUADA SEMICONDUCTOR

2. A& K

AFIR HC32F146 Z %1 Starter Kit #0/4  MRah 2245 . 3 5ei)a, 7 o] LS 5 4% bl
AAIS AT W B HAE A

2.1 Ak
IR DL T 2 B 223 HC32F146 2751 Starter Kit 04k

MG http://www.hdsc.com.cn/ T %k HC32F146 % 4%1) Starter Kit 22352 F, XN 25 T %
LM, AR, TR, BEE. T B ARE A

2.2 MERE
HC32F146 £ % Starter Kit 3 — ANRAFEBIFE Y, XA B pT A s Thae .

2.3 AT R
1. J1. J3 BhEkWrIT, 4 Bk&FsE, IP3 fdE; SNENE USB Lk—umd s flin b, —imiddes|
CN1 b, MRS R EIE /<A LED4 5%, FonHmIEIIRE IR
2. WEDIREIER, WIMIFaG=R 58 3l e LB S 1f->XE 8 putty.exe
3. 1E putty & I E S35, 76 Session->Connection type i3+, % Serial.

I % PuTTY Configuration

Category:

Basic options for your PuT T session

- Specify the destination you want to connect to
= T'?f'“é:ioa y Serial line Speed
- Bell Ccoma 115200
- Features Connection type:
- Window T Raw ) Telnet ) Rlogin ) 55H i@ Serial

- Appearance
gzﬁavinur Load, save or delete a stored session

. Translation Saved Sessions

- Selection
-~ Colours Default Settings
- Connection
- Diata

- Proxy
- Telnet
Hlogin
+- 55H

- Serial

Close window on exit:
() Mways () Never @ Only on clean exit

[_Oeen |

2-1 ¥T7F putty
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FDSC EAESH

4, FERA:FLH R Connection->SSH->Serial HlC & £ 3 5 CAT DLEE ¥ 255 3 28 i 11 i o 3%
MRS, XERERI 8, JWAER 115200, ¥l 8 {Fibfr 1, LB, A Open

I H .
Err o ==
Category:
I_ =- S!essiu:un Basic options for your PuTTY session
- Ten |_-|:|g|ging Specify the destination you wart to connect to
—I- Temina o
. Keyboard Seral line Speed
. Bell ComMs 115200
- Features Connection type:
= Window Raw Telnet Rlogin S5H @ Serial
;;.ppea!ance Load, save or delete a stored session
- Behaviour
. Tranelation Saved Sessions
- Selection
- Colours " S
Default Settings
= Connection |ﬂ'
. Diata | Save |
- Proogy
Telnet | Delete |
Rlagin
+- 55H
""" Sefial Close window on exit:
Always Mever @ Only on clean exit
About [ Open ] | Cancel

K 2-2 wE RS

5. miididAL EIY Enter B TINARE T, FeBR AU B 9w 5 JF Sl Enter $Z8RiZ
AT LI RE o

2-3 WIFRFL '
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2.3.1 WFE 1 B

UART il :

XN R CMSIS DAP A1 HC32F146 %1 MCU Z [8]ff] UART IB{EDhfE. %8N 0
JE BN Enter, &5 HE5HE “OK” .

EREARINE

XA RN MCU T 8h 32.768KHz J& &5 IE W By . %8 1 )5 B4 Enter, FEF¥
Rl I b B OIRAS IR A, Bes TFE S E “OK” .

LED ik

XANFENNR LED. %85\ 2 J5 H% N Enter, LED3 KGR IR “5->K->5" i fe,
% Enter 25K, &5 75 B8 “Tested” .

FaAEE -

KA RN S s T e . TN 3 5 FE 4 Enter, FR#EIR [l 7R MR #k USER

Ht, BURJTIE SRR “OK” .
RS 25 I«

XA FEM ARG B THRE . FBEE N 4 J5 5\ Enter, NS 30K R A TR IR A,
1% Enter ZE WK, &JE TS ER “Tested” .

I JEE A SR K

AR R AL KA ThRE . T8 5 ) FEsIN Enter,  Hf LU0 S TR #EAT Sr s,
T U iR A4k, $%2 Enter 2RI, 75 ER “Tested” o

9o v I~ ]

m

K 2-4 AR e
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® EEPROM jillik:

KA RN EEPROM A7 Dhfig. 148EH A 6 J5 fHA Enter, F2/5¥ EEPROM HEATHIA
DUR B 5 Ml o LU A, R 5485 H i “OK” .

® | CD Uﬂ”lﬁ

YR ON 7 J5 5N Enter, LCD R 24ATIREE, % Enter 590K, &5 65 5o
“Tested” .

K& 2-5 LCD it FR T
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HUADA SEMICONDUCTOR

3. A HL RS

A FEA 4 HC32F146 F41 STK REAFRHE o ATF KB f i 3= 4045 HC32F146X MCU
B/NF G0 CMSIS DAP i 5E B Jz FoAth LA A Lt o mldd 218 USB 34Tk, B SPX1117
TR S 3V3 Al—A> USB fli L 5V #24k MCU Zfr R sk, A nl AR o 75 Bk B A @ 1 ik v
J&: MCU ZMiHz AM 1 32.768K i EaHR, 73 Al AR A1 e 1A A AR B e

3.1 RGHEHE
A STK IR A GHEE AN T

R RS ER

HC32F146 &% NS ER EE

3-1 RGHER]
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HEXESHE

HUADA SEMICONDUCTOR

3.2 TEERAE
A A HC32F146 £ %1 Starter Kit fff-45 71 .
3.2.1 CMO0+%%1 MCU
HC32F146 %741 Starter Kit #4 # K IhFE . =4 32 i ARM® Cortex®-MO+ P 1% 1) HC32F146
ZFf) MCU. HC32F146KATA &4 K HC32F146 ZFIH A R—3k MCU, 5 ki BhiiZ
48MHz, B A5k 128KB FLASH. %k 8KB SRAM. 1 MASH] Bl WA 32 N a8 4 M
SRR AP R b S AN R IE RS, W1 LCD 8% . ZIhAeE B SR 0 (UART. SPILL 12C) .
12 {7 A/ID #4:8%. GPIO. VC. OPA %,
3.2.2 CMSIS-DAP
HC32F146 &% Starter Kit #5%% CMSIS-DAP i #5H L sZE CMO+ HC32F146 & %1 MCU )4
FEEIRTIhAE. CMSIS-DAP [E {3 #F Serial Wire Debug (SWD) 11, [A}, CMSIS-DAP fbi
WALET CNA HEHER R (Ff I3 BhZRIE ) .
Ll S t :
—I;u —F'LI CMSIS-DAP compatible JTAG + Virtual Cam Port :"k_ o H“m .
& 8
| T ) ! H e i )L USBDevice
o o oo sm e s L L‘E \'
— — a Tl
——4 i " | |
YAMESCR] | ,:'\f‘;:;'g.s:!“{"‘m":.‘ i Lﬁu,
TLUANOLSING_ JINTOD H.):& ;:‘:“; oo :‘rl:?w'l‘ I I
3-2 CMSIS-DAP %
STK B4/ - FM Page 12 of 25



FOSC EAESR

3.2.3 SWD #11
HC32F146 Z 7% Starter Kit $24it SWD 2 1 CN4 USRS gRFESE . CN4 ZFr7E ARM® 2.54mm
5-pin #21,
Vin
CN4
|
2
Pin28 RES,M 4‘??!' SWDIO 3
Pin27 R24 AR SWCLK 4
Pinl3 R22 ’ 47TR RSTB 5
183 2.54mm,5Pin

K| 3-3 5-pin SWD ;[

3.2.4 USB #:[1

HC32F146 &% Starter Kit nJ ik USB #2 Lt 47 it i, USB Al —> micro USB %423 CN1
l:l o

3.2.5 GPIO &1

HC32F146 %% Starter Kit i id #b5 GPIO 1% H]—/ LED. USER BUTTON #l1 BUZZER. %
USER BUTTON A1 LED @i £4% 3-1 11 5| iEH: 2] MCU.

#* 3-1 GPIO B 11 3hfE
W5 £riThEE EERRA
22 | P23/INT06_1/COMS5/SEG38/SIN4 1/TIOB2_1 BUZZER

23 | P24/INT07_1/COM4/SEG39/CTS4_1/TIOA2_1 LED3

51 | P62/INT12_1/SEG16/SCS50_1/TI0OB0_2 USER BUTTON

STK B4/ - FM Page 13 of 25
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HUADA SEMICONDUCTOR

4.1

41.1

BAFIT

AT EA 4 HC32F146 251 STK AT RIS . Gl A A F P B AR AR B B A BT
REPE EFIFREN, N5 5 SR ATR

TR

X CMO+ HC32F146 R I SCF il 5 =77 Tools/IDE #EATIF A, il iR H O il bf i 4%
R HOFF R T B A Z2 DU AR BT R A G, BEFFRAR L ES RS 3L 1AR Fi
Keil 4. (M) IDE:

® |AR Embedded Workbench for ARM

® Keil ARM MDK® Microcontroller Development System

FPrdsd LA R N T RIS, 22 ig AT O R n] BE R 2L License VYRRl o S8 TR f
F VRS A B D ae T ) Help H 285 AR B SCRS .

#T IAR #TJF example
PUR P IRIR T 40 7E IAR IDE 358 N1 HF. gwid. 1217 example Wi H . 1E#i %35 IAR #F 5
A] I T template.eww 72

1. iZ4T 1AR Embeded Workbench IDE V7.70(8 5 &1 A -
2. 5.t File>Open>Workspace £ T2 template.eww FT7E H 3.

% IAR Embedded Workbench IDE

Edit View Project Tools Window Help g#—_._,
New 3| - ] B
Open 4 File... Ctrl+0
Close Workspace... | ﬂashloader
Save Workspace Header/Source File Ctrl+Shift+H |
Save Workspace As... T T T T T TN output
Close Workspace .
settlngs
Save Ctrl+S
Save As. L template.eww

Save All

Page Setup...

Print... Ctrl+P
Recent Files 4
Recent Workspaces

. ing
Exit linking,
i

4-1 1AR T LHE

3. fiili Project>Rebuild All 47 T1%

STK B4/ - FM Page 14 of 25



HUADA SEMICONDUCTOR

4. TfifR HC32F146 &%) STK JF AARBELRI% R FAR 4-1 EEHL.

* 4-1 AR B E
i W CMSIS-DAP i {7,
J4 HEHE USB [a] MCU fit e
Jp3 FEHE 3.3V R
J3 W I MCU iz 47455

5. 3%# USB #| CN1 1, MEHIEIE/RIT LEDA (47D 275 Hst.

6. s T EA2 ) Debug, %+ Project>Download and Debug 146 2 A1 .
7. s Run BIFR I N ERET .

8. smiifi Stop EIFRF ILFRF

AR Y Y Y E "“HIJIU&I

1 2 3
&l 4-2 TR P I
K 4-2 TR PRI ]
1 Compile/Make Y PRI
2 Stop ¥k
3 Debug and Download YA 2

9. & F 15 5% IAR Embedded Workbench IDE 15 &, i it Help.

4.2  FEHITHE

HC32F146 # %1 Starter Kit $24 T 1 AMFE] T2 LA B & & PO AR A STK. FRH IR
#4845 /& LT Device Driver Library(DDL)%# 5 ). 1% DDL $24t T APIs fit F P ¥ aa A FE e 4
o

R 4-3 FEGI TREN 4

b Z TR T8 AD REE.
LCD E7n. 8k, igngss. UART.
12C Thfk, LR e Ak TR E,
AT N T R .

1 template

STK & - Fit Page 15 of 25



FOSC

HEXESHE

HUADA SEMICONDUCTOR

4.2.1 Template

N LA template 514

® [ FEffiiA

247 CMO+ HC32F146 8 Fr i AMae hRe, ml s & 1 H S8 s db AT i ¢,

# DDL L#%:

AT ERANOREPFERE, 2 TREPT P R CAR AR STKJF AR L.

® IiESi R

1. ¢ HC32F146 %% Starter Kit JT A& 4
7E IAR Embedded Workbench 5% Keil uVision IDE P55 14T L#%.
Build iz T#E, A5 MR TSI HIRT K.

BATIEF
FIF putty T B

o & D

@ PuTTY Configurs

Category:

=- S[ession

[=I- Terminal

- Keyboard
- Bell

- Features

= Window

- Appearance
- Behaviour
- Tranglation
- Selection

- Colours

- Connection

. Data

- Prongy
- Telnet

- Rlogin

+-55H

- Seral

STK B Flit

1+ CN1USB 1

L, WEPRPE 115200, s Open IZE1IEEIT KA PC,

Basic options for your PuTTY session

Specify the destination you want to connect to
Speed
115200

Serial line

coma

Connection type:

1 Raw () Telnet ) Rlogin () 55H @ Seral

Load, save or delete a stored session

Saved Segsions

Default Settings

Close window on exit:

I Mways () Never @ Only on clean exit

4-3 B RIS
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6. JEIBEALE A D NME R AT, BN R B FRE T4, B I AT R R T
e .

K 4-4 echo ik
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HUADA SEMICONDUCTOR

43 FEFRS
R EFGA- Bt 1IDE A1 ISP A EL TR B S .

43.1 IDE &E

A Z BN Fr 85 DAP ATILINK piffse 5773, ARIE DT Bt i N B F A, JFRE N H AT
HEFE AR T 8730, NI L CMSIS-DAP NI A8 7 T 8077

1. A8 TR CfE-> “Option”, fE “General Option” HLi%&#E “Cortex-M0+” P #%;

r 3
Options for node "hc001_template” S EEEEEEEEREE s ﬂ

Categon:
General Options -
Static Analysis P
Runtime Checking
I C/C++ Compiler

Target |0utput ILibrary ConfigurationlLibrary Options |MISR ¢ "

Assembler
Qutput Converter Processor variant
Custom Build

@ Core _COrtex—M0+ -
Build Actions

Linker ) Device |Home B
Debugger

Simulator =

" Angel Endian mode Floating point settings

CADI .

CMSIS DAP @Little gl None -
GDB Server (Big
LAR ROM-manitor -/ BE32
Tet/TTAGjet (@ EER
I4ink/)Trace Advanced SIND (NEQH)

M TI Stellaris

ol - -

Il Macraigor

PE micro
RDI

STHLINK
Third-Party Driver - oK } l Cancel

4-5 PN

2. {t Debugger->Setup B+ Driver 772y CMSIS-DAP

~ 5
Options for node "template_template” ﬂ
Categony: Factary Settings
General Options -
Static Analysis
Runtime Checking Setup ‘ Downleoad I Inages I Extra Opticns |Nulticore | Plugins |
ni C[C++ Compiler
Assembler Driver Fun to
Qutput Converter CADI - main
Custom Build inulator
Build Actions Angel I
" ALl
iooulate 2 T4R RON-monitor
Angel I-jet/JTAGjet
a0 J-Link/J-Trace
i TI Stellaris
CMSIS DAP Macraigor £
GDB Server g%lmi Cro
TAR ROM-monitor ST-LINE meul TAR\HCSZL1 G, svwd B
Ijet/{ITAGIet Third-Party Driver
Idink/ITrace TI MEP-FET
I Stellaris —TL DS
i Macraigor
PE micro T
ROI
STLINK
Third-Party Driver - [ Ok } [ Eance

4-6 WP IRE]

STK B4/ - FM Page 18 of 25



FDSC &A%

HUADA SEMICONDUCTOR

3. 7F CMSIS DAP ->Interface B4 1175 X~ SWD:

Options for node "template_template” lihj

General Options -
Static Analysis [
Runtime Checking Setup | Interface |Breakpeints

Cfc+ Compier Probe config  Probe configuration file

Assembler _ R

Oustput Converter @ Auto Owerride default

Custom Build ( :_'From fil

Buid Actions (O Ezplici Select
Linker

Debugger Interface Explicit probe configuration
Simulator E (") ITAG Multi-target debug swstem

(R © iz 0
W o - Target with multiple ©
0

18R ROM-manitor Interface

Iink/1-Trace

1 Stellaris

Macraigor

PE micro m

RDIL

STHLINK

Third-Party Driver - I oK ] [ Cancal

4-7 SRR E O

4, WEIF TREDE, midi “OK”, ik mdi“Compile”. “Make 4w BFiEH:, 4mifi@Id 5N
Jc “Error”,

Messages

Building configuration: template - Release
Updating build tree..

Linking

template.out

Corwverting

Total number of errors: 0
Total number of wamings: 0

4-8 HiBR(E 5
5. rii“Debug and Download ik FEAEF, LED2 [Nk, SEAFRET T 258 K.

432 ISP 15

1. #T7F HC32F146 %1 Starter Kit #/7 T ## fF HDSC MCU Programmer .
2. B\ 1 BRZRWTIT, J4. I3 BhAAEE: AREK USB Z—imiE iR M b, —IimiEREF] CN1
b, EEREWRBEIRIERT LEDS 5, RoRHIEIHAREIE R .
3. HJREIHAEIER, WINSEHITHR & E HC32F146 2% Starter Kit Xf M ff) COM ¥t 15 2l
W-> RGN 4> R G -> B8 B ->
4 73 &0 (COM # LPT)

HS

e ? HDSC CMSIS-DAP Communications Port (COME)

4-9 B A U 5
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FOSC EAESR

4. J57) HDSC MCU Programmer %44

wwe HDSC MCU Programmer = S|
i EE
MCEE MCU FlashiZE
By [HoazRa b/ HEsEM Aech v| Fiatbnt  oooooooon  FRimb ox RS R
SRR [4 mz ~| B 512 EIGRS WEEH
Hew W1 D: Wiyfelder (heckan\SVHNAD. [ TIH4E 256 YIRS
[mbit [coms - EE ] ARES:
£
K11
4-10 HDSC MCU Programmer |
2 4-4 HDSC MCU Programmer #5425t
TH THH Thge B
Hbs MCU | 18 H BRI 1 MCU R 5 ik
REDTES MR FARARAE T 0 SR AR ik
MCU ¥ | Hex SCfF MR BN R H AR hex S ik
it 1 S E*Tff)i 1T PC XTF“EI’J COM i | @bk
ﬁﬂﬁﬁﬁ“ﬁ%fﬁ”ﬁ H Tﬁﬁ%ﬁ%fﬁ
PR R R B TUHERR ™, R
bR BRI, R CAREFERET N | ik
ﬁﬁﬂb@ﬁﬁkﬁ“ﬂﬁ BEERHAE
FHEA RIS - FLASH 2 15 4 34 Al ik
g iz K Hex SCIF R 38 H AR K FLASH A Wik
(e IE WAER T FLASH B 2 5-57% [p::
ﬂﬂ?i‘}% TEANERLE, WAEMKEER <%
7 P, T, AR, RIESER | T
éﬂAIjJ
A% FITERHUE 7 (9 FLASH w50 Al ik
R AN F TS5 FLASH Hr i s 5 6k Cipe
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FOSC EAES#

5. 14 HARHR ISP G SLUERE: B AR MCUL @R RAIR . Hex SCPF. i M 13 B DU T 240 -
< Hosc ey g s
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